
Using InterMapper

You experience InterMapper through the Map List Window, where you view a list of available

maps. when you open a map, it appears in a MapWindow.

If you are using InterMapper RemoteAccess, you may be viewing more than one map list in the
Map List window; one for each server.

You can customize InterMapper by defining Helper Applications and by specifying what actions

should be taken when you double-click an object on amap. You can also set user preferences for
InterMapper and InterMapper RemoteAccess.

Creating Maps

Use this section to find out how to start your map, to use Autodiscovery to find and map each

device on your network, and to add devices and networksmanually. Once you are familiar with

what maps are and how you can use them, you can add devices to your map by importing them,

and can export data from maps for use in spreadsheets and databases.

You can even place a physical map image in the background of your map, and use geographic

coordinates as you import to place devices automatically at specific locations in relation to the
background image.

Use InterMapper's different probe types to query your devices in specialized ways to give you
more accurate information about the states of those devices.

As you become more familiar with what InterMapper can do, you can add networks and scan

them. You can create sub-maps, allowing you to view large networks through an overview map,
"drilling down" to see more detail as needed.

Arranging Your Map

Once you have created your map, you may want to rearrange devices into logical groups,

change the appearance of devices, change the device labels, or add text or a background image

. For maps with large switches, you may want to hide some detail. For tips on arranging your map,

see Arranging Tips.

Notifiers and Alerts

You can set up devices to alert you to problems in a number of ways. When a device goes the
specified state, a notifier is triggered, and alerts you to the problem.

You can create your own notifiers and configure them to send an E-mail message, page

(through a modem or network), send a text message to a cell phone, or execute a script or sys-

tem command. You can also open aWinPopupwindow on a Windows machine, send an entry to

a Syslog server, or send an SNMP trap.

For each map, you can define a default set of notifiers to be attached to a device. You can also

attach one or more notifiers to one or more specific devices. You can also create groups of noti-

fiers and assign them to a device all at once.

If a device goes down, and other devices are attached to that device, you can set a Vantage Point
. InterMapper can then determine that the attached devices are dependent on the down device,

and will not send notifications for those devices.
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Monitoring Your Network

InterMapper begins polling devices as soon as you create your map. A great deal of information is

immediately available by viewing the Status window for a device, network, or link. You also view

and edit a device or network's information from its Info window. For routers, switches, or other
devices with interfaces, you can view status or other information about specific ports through the

Interfaces window.

You can set thresholds for packet loss or network traffic, and InterMapper alerts you when a

behavior is out of range. You can create strip charts that graph one or more data values asso-

ciated with a device. You can also view a detailed Event log and Outage log to help you trou-

bleshoot problems accurately. You can even create new log files for logging specific data.

If a device goes down, you can acknowledge the problem, which prevents InterMapper from con-

tinuing to send notifications. There are several options for acknowledging problems that allow you

to control the resumption of notifications after acknowledgement.

You can collect data from devices and save it in the InterMapper Database, through the Inter-

Mapper DataCenter. The data can then be retrieved for use in reporting and analysis. You can set

policies to specify how much data is retained and how long it is retained.

Server Settings

Use the Server Settings panel to view information about InterMapper, to set preferences, and

to configure InterMapper's Remote,Web, Telnet, and Authentication servers. You can also main-

tain InterMapper's firewall and user list, enable and disable or control access to maps, and

create notifiers.

InterMapper Reference

Use the InterMapper Reference to view comprehensive lists ofmenu commands, details about

the available device probes, file and folder locations, and learn advanced data import and export

techniques. You can also learn how to use and customize the InterMapper web server, and how

to use the InterMapper Telnet server.

Troubleshooting InterMapper

Use the Troubleshooting section to help you learn about IP addresses, Domain Name Servers,

SNMP,WINS Names, and view a number of frequently-asked questions.
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The Map Window

You view any map in a Map window. Below is one of the example maps installed with InterMapper.

For an in-depth explanation of the elements that appear in the map window, what they mean, and

how to use them, see Monitoring Your Network.

The Title Bar

The Title bar shows the map's title, its state, and has standard controls for zooming, minimizing,

and closing the window.

The Menu Bar

The Menu bar contains the map's menus.

For a complete reference for each menu, see the Command/Menu Reference.
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The Toolbar

The Toolbar contains buttons to toggle the map's edit mode and to switch from one view to

another.

Icon view
Shows the map as individual icons, with their interconnections.

List view
Shows the devices on the map as a list, with columns for the device's

status, name, address, probe type, and current and previous condition.

● Click a column heading to sort by that column.

● Click again to sort in reverse order.

It is convenient to sort by the severity so the most serious con-

ditions appear at the top of the list.

Notifier view
This view lets you see which notifiers are attached to each

device on a map. Another way to think of it is as a "responsibilities" view -

what devices apply to a certain notifier.

● Select a particular notifier from the dropdown menu; you can see

the checkboxes for all its recipients.

● To set a value for all devices, hold Alt or Option, and set a value.
The value you changes to the selected value for the entire column.

This works on all check boxes, as well as on the Delay, Repeat,

and Count columns.

Chart list view
Shows the list of charts for the map.

● Double-click a chart name to open the chart.

● Right-click the button to open a particular chart without switching

the view.

● Click the pencil icon at the left end of the tool bar to switch the map between Monitor mode

and Edit mode:

In Monitor mode - The map is not editable, and status windows
appear when you click and hold a device, link, or network.

In Edit mode - The map is editable. Status windows can be
opened with menu commands.

- 34 -



The Map Window

The Map Legend

The Map legend to the right of the toolbar shows the different states of the map and the number of

devices in each state. It also acts as a filter in list view.

Badge Color Meaning

Red

(Flashing)

Down - No response has been received from the device

within the specified timeout period.

Red

(Solid)

Critical - The specified threshold for critical state has been
met

Orange Alarm - The specified threshold for alarm state has been

met.

Yellow Warning - The specified threshold for warning state has
been met.

Green Up - The device is working below the specified thresholds.

Gray Unknown - The device is not being polled, so its state is
unknown.

Purple Searching - The device is searching for adjacent routers
(during auto-discovery) or is tracking down unnumbered

interfaces.

Acknowledge - Timed or Indefinite - The device's
problem has been acknowledged and notifications are

being suppressed, either indefinitely, or for a specified

period of time.

Acknowledge - Basic - The device's problem has been

acknowledged, and notifications are being suppressed until

the device comes back up, at which time the checkmark is

cleared.

List Acknowledged Devices - (Filter button) List all
devices that have been acknowledged.

List Un-Acknowledged Devices - (Filter button) List all
devices that have not been acknowledged.

● Click a legend icon to view a list of devices that currently in that state.

● Click the icon again to go back to the previous view.

● Shift-click icons to view devices in more than one state.

Example: Shift-click the Alarm and Warning icons to see any devices in either of those

states.

● Click one of the Acknowledge Filter buttons (to the right of the legend) to list only acknowl-

edged or un-acknowledged devices.

Note: The filter buttons work with in concert with the legend icons - clicking a Filter button
shows only the devices in the selected state that are acknowledged or un-acknowledged. It

is possible to click a filter button and see no devices.
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The Map Area

The Map area is the "canvas" on which you create your map. To get started, take a look at Cre-

ating Maps. It is full of information about starting your map. The Creating Maps section is full of

information for creating, arranging, and making your map look just the way you want it to look.

You'll also find a quick reference of editing shortcuts.

For an in-depth explanation of the elements that appear in the map window, what they mean, and

how to use them, see Monitoring Your Network.

The Status Bar

The Status bar contains controls for switching in and out of map edit mode, setting the polling inter-

val, and zooming the map.

The Poll Interval drop-down menu
sets the polling interval for the map.

The Map Zoom drop-down menu

sets the zoom factor for the map. If

you choose Auto, the map zooms
automatically when you resize the

window.
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The Map List Window

Use the Map List window as the primary interface to InterMapper.

● With InterMapper, you can control all aspects of the InterMapper server running on your

local machine. You can also disable a map by right-clicking it and choosing Disable Map.
● With InterMapper RemoteAccess, you can access multiple InterMapper Servers from the

same machine. If you have administrator access, you can edit all server settings on a

remote server. You can also disable a map by right-clicking it and choosing Disable Map.

The menu items available in the File menu differ slightly between InterMapper and InterMapper

RemoteAccess. For more information, see the File Menu reference.

The Map List Window

Use the Map List window to view a list of maps. If you have InterMapper RemoteAccess, you can

also view a list of other available InterMapper servers, to log into one or more servers, and to

view a list of maps currently running on each server.

The Map List Window showing the example maps. Position the mouse

cursor over a map in the list to view its DNS Name and/or IP address,

and the port on which it's listening for InterMapper RemoteAccess

connections.

Arranging your Maps into Folders

You can arrange your maps into folders as shown above, using the Server Configuration>Enabled

Maps pane of the Server Settings window. For more information, see EnabledMaps.
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Using InterMapper RemoteAccess

InterMapper can make its maps available to people who are away from the server. They can use

a program called InterMapper RemoteAccess to view and configure the server.

InterMapper RemoteAccess's Map List window

InterMapper RemoteAccess is a Java program that can run on Mac OS X, Windows NT/2000/X-

P/Windows Server 2008, or various flavors of Unix/Linux.

InterMapper RemoteAccess is capable of configuring every aspect of InterMapper. For more infor-

mation about enabling the Remote server, and a description of how to set up access permissions

per-map or by IP address, see The Remote Server.

Note to Windows users: By default, XP SP2 and Vista both have significant firewalling turned
on. You will need to create exceptions ("poke holes") in the firewall in order to use the remote

server, web server, telnet server, or DataCenter server as well as to monitor SNMP traps. For

detailed information, see http://dartware.com/support/tech_notes/WindowsXP.html.
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Using Helper Applications

The Helper apps context menu

You can use helper applications to get information

for creating maps or to troubleshoot problems.

These programs are available through a con-

textual popup menu.

To invoke a helper program:

1. Control-click or right-click on a device.

2. Select one of the helper applications to

launch it using the device as its target.

For example, the 'Ping' helper application

invokes the system's ping utility: generally

/sbin/ping on Unix, Linux or MacOS X, or

ping on Windows. Including a URL as the
helper application will invoke the system's

tool configured to handle the URL.

Notes:

● You can specify the same helper application for several devices at the same time if more

than one device is selected. The helper app is invoked for each selected device.

● The helper application that is invoked is platform-dependent: generally, InterMapper will

open a terminal program and issue a command to run the helper.

Editing Helper Applications

Use the Helper Applications Customize window to

modify the built-in helper applications, and add new

ones.

To view the Helper Applications Customize

window:

1. Right/control-click a device. A drop-down

menu appears.

2. From the Helper Applications submenu,

choose Customize...

or

● From the Monitor menu's Helper Apps sub-

menu, choose Customize...

The Helper Apps window appears.

This window shows the list of built-in helper apps as well as any user-added helper appli-

cations. To add, edit, or remove a helper application, see Adding or Editing Helper Apps

below. It also describes the Launcher that is a platform-specific tool that is used to launch a
helper app.
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Adding or Editing Helper Apps

To add a new

helper application:

● Click Add... The
Edit window

appears, showing

default values for

the new helper.

To edit an existing

helper:

● In the Helper

Apps window,

click the helper

you want to edit.

● Click Edit... The
Edit window

appears, showing

the current

values for the

selected helper.

Enter values as follows:

● Title is the
human-readable

name that

appears on the

Helper Appli-

cations sub-

menu.

● Path is the full
file path name for

the helper appli-

cation

● Arguments that
will be passed

along to the

helper appli-

cation.

Finally, the Command

Line is the actual string that will invoked. You can configure this string using the ${TITLE},
${PATH}, ${ARGS}, and ${LAUNCHER} macros that will be substituted when the command is

invoked. In addition, you may use ${ADDRESS} and ${PORT} macros to represent the address

and port specified for this device.
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Removing a Helper Application

You can remove any helper application definition you have created. Built-in helper apps cannot be

removed.

To remove a helper app definition:

1. In the Helper Apps window, click the helper you want to remove.

2. Click Remove...

The Launcher

The Launcher is a plat-
form-specific program

that allows you to

invoke another pro-

gram from Inter-

Mapper.

How does the Launcher

invoke an application?

The method of launch-

ing an application is

platform-dependent.

● On Windows,

InterMapper uses

a command shell.

● On OSX, Inter-

Mapper opens a

Terminal window.

● On Unix/Linux, InterMapper invokes the shell.

Using Default Values

For each platform, there is a default value for each built-in helper app. You can reset a helper app

to its default values.

To reset a helper app to its default values:

● Click the Default button. The launcher string is reset to the default value for that platform.

Note: You don't have to use the launcher for any helper, but it's often the easiest way to invoke
another program on your computer.
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Using Double-Click Actions

InterMapper defines Double-

click Actions that it will perform
when a device is double-clicked.

Many probes have a pre-defined

double-click action, but this can

be overridden.

To change a double-click action,

right-click on the device, and select the proper choice from the sub-menu:

Helper App

Double-clicking will invoke a specified helper

application. This helper application runs on the
same machine as the InterMapper client. Select

the helper application from the current list of

helpers.

URL

You may supply a URL (http, ftp, telnet, etc.)

and InterMapper will invoke it when the device

is double-clicked. Enter a URL to be invoked

when the device is double-clicked. You may use

the following macros: ${address}, ${port}.

Built In

InterMapper can invoke nearly any of the menu

commands as a result of a double-click. Select

the desired item from the hierarchy of menu

items.
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InterMapper User Preferences

Use the Preferences command, available from the Edit menu, to set

user preferences for the InterMapper user interface. These settings

affect only the copy of the InterMapper or InterMapper RemoteAccess

you are running - it does not affect other users' settings.

To view and edit InterMapper's preferences:

1. From the Edit menu, choose Preferences... The Preferences
window appears.

2. In the left pane, click the name of settings you want to change. If

necessary, expand a section to view the more settings. The

selected settings panel appears in the right pane.

Appearance

The Appearance section controls various appearance parameters. There is currently one panel in

this section,Map Style.

Map Style

Use the Map Style panel to set your preference for the style in which your maps are displayed and

your preference for whether to use anti-aliasing functions to display graphics or text.

● Use 3-D map style - (checked by default) Check this box to use the current three-dimen-
sional display style, with gradient colors, rounded rectangles, and status icons.

● Anti-aliasing - Choose from this dropdown menu to select the elements of the map to

which you want to apply anti-aliasing functions. You can choose Default, Graphics and

Text, Graphics only, or None.

Behavior

Use the Behavior section to specify your preferences for double-clicking map elements and for

how you want child windows, such as strip charts and status windows, to behave when a map is

inactive.

Double-Click

Use this panel to specify a default action to take for a device or network that doesn't have an

action assigned. Use the Action dropdown menu to choose from these options:

● Helper App... - Choose a helper application to launch.
● Open URL... - Enter a URL in the Action text box.
● Built In... - Choose an InterMapper menu command from the menu tree. By default, the

Info window opens.

Child Windows

Use this panel to specify whether charts and status windows are hidden when a map becomes inac-

tive.

● Hide charts and status windows when Map is inactive - Click to select this check
box to hide strip charts and status windows for any map that is not the active window. If the

box is not checked, any open strip charts and status windows remain open.
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Version Updates

Use this panel to enable or disable the Automatic Update function by selecting or clearing the

Automatically check for updates box and selectDaily,Weekly, orMonthly from the drop-

down menu. This function is also available from the InterMapper Control Center. To check for

updates immediately, use the Check Now button on the InterMapper Control Center.

Performance

Use this section to specify your preferences for animation rate.

Animation

Use this panel to specify your preference for animation. Faster animation looks better, but may

use more CPU power than you would like, if you are running a slower CPU or have some very

large maps.

● Animation rate - Choose an animation rate by moving the slider left for slower rates or
right for higher ones. The selected rate appears in the upper right above the slider.

Control Center

Use this section to specify your preferences for the InterMapper Control Center.

Task Bar Menu

Use this panel to specify whether to show a task bar icon for the InterMapper Control Center.

● Show status in task bar - Select this checkbox to show the status icon in the task bar
(Windows) or menu bar (Mac).
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Starting Your Map

When you launch InterMapper, a Map List window appears. It contains several demo maps, which
show examples of network maps, and contains brief descriptions of the elements appearing on the

maps. Double-click a map to open it.

After you have explored the demo maps, you are ready to use the Auto-discover function to

create your first map.

Creating a New Map

To create a new map, choose New Map... from the File Menu. The New Map Constructor window

appears:

Enter a map name, and click Next >.The second page of the New Map Constructor appears.

● Autodiscovery - InterMapper's Auto-discover function automatically scans your network,
looking for network devices to add to your map. It uses several heuristic techniques (includ-

ing SNMP probes, ICMP and AppleTalk echo packets, and DNS and NBP queries) to discover
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